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Introduction 

The analysis of  an ongoing Tsunami requires a dedicated Decision 
Support Tool that allows understanding the phenomena 

he Joint Research Centre of the European Commission is operating the 
Global Disasters Alerts and Coordination System (GDACS, 
http://www.gdacs.org) since 2003. This System, jointly developed by the 

European Commission and the United Nations, combines existing web-based 
disaster information management systems with the aim to alert the international 
community in case of major sudden-onset disasters and to facilitate the 
coordination of international response during the relief phase of the disaster. 
When new natural disasters events occur automatic analysis reports are created 
and sent to the users by mail, fax or SMS (Short Message System). 

 
As a consequence of the 26th December Tsunami JRC included Tsunami 

modeling in the GDACS system in order to improve and complete the automatic 
reporting system. At the beginning of 2005 a travel time wave propagation model 
was included (Annunziato 2005). This model calculates the wave arrival time 
independently on the initial tsunami wave height. In 2006 a new analytical tool has 
been developed in order to be able to provide also the height and identify the 
locations with higher risk of tsunami damage. The calculation tool which was 
organized at JRC Ispra using this model allows performing automatic on-line 
calculations of Tsunami as soon as any new event is detected on the international 
seismological networks. During the on-line calculation (which takes about 30-40 
min) to be completed, a web site page in the GDACS portal, is constantly updated 
with the new information coming from the model. Therefore a user connecting 
with that page after an event can follow the progression of the calculation  

[ 1]. 
 
In order to understand what is really occurring during a real event, however, 

the sole web page is not enough because it shows the estimated sea level but does 
not show real sea level and therefore it is difficult to take actions using values 
estimated on the basis of Magnitude and Location only. The possible actions 
deriving from the analysis depend on the user analyzing the event: in the case of 
an official in charge of protecting the people on the coasts it could be the decision 
on a possible evacuation; in the case of on duty staff of an international 
organization it could mean to inform top level management of possible need for 
support in the potential consequences of a Tsunami. In all the cases the objective 
is the understanding of the real situation which is the objective of the Tsunami 
Analysis Tool (TAT). 
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The Tsunami Analysis Tool is a software developed by the Joint Research Centre 

to support the analysis of the Tsunami events. The report describes all the options of 
the software and should be able to enable users to benefit from all the features of the 
programme. It can be used with any Tsunami software results, provided that the 
format of the files that the programme expects is preserved. One of the appendices at 
the end of the document explains the format of the data required by TAT. 
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How to quickly analyze an 

ongoing event 

This chapter describes which option to activate in order to quickly 
analyze an event and compare with analytical results. 

et’s suppose that we want to analyze one of the calculations that have been 
done for the 11 March 2011 Tsunami in Japan and that we know its address as 

http://tsunami.jrc.it/model/swan/Reports/2371/ 
After starting the TAT programme, you should click on Windows menu and 

select New Window. A new analysis window will open and you 
need to specify the above address in the box labeled as “Select 
your case” and press Return or press the button “Show”. You 
need to be connected in Internet or order to correctly analyse the 
case. 

The programme will load a number of information 
describing the conditions for which the calculation has been 
done such as Epicenter location, depth, Initial Height, Fault characteristics etc., 
FIGURE 1.  

By selecting the various tabs it is possible to visualize additional information. 
The main window is the one indicated as “Max Height” that shows the maximum value 
of the height in the calculation space, FIGURE 2. This visualization allows seeing which 
are the available sea level devices that can be compared with the estimated calculated 
values. Also on the same window a number of locations are shown with the estimated 
height on the coast. By passing the mouse over the various circles (sea level) or squares 
(locations) it is possible to understand which is the device or the location (with its 
maximum height). 

We want now to know how much the calculation is accurate respect to the real 
event. If our calculation is accurate on several measured values, it means that the 
estimation of the heights at the various locations is reliable. Very often there are not 
enough sea level devices to show the height in every coast thus the only possibility is to 
compare them where available and use the calculated value to derive all the rest. 

Chapter 
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event may be an internet 

address or a location on the 
local disk which contains the 
files needed by TAT to 
perform the analysis. This 
folder could also contain the 
results of a scenario 
calculation. 

http://tsunami.jrc.it/model/swan/Reports/2371/
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FIGURE 1 – Initial screen showing the characteristics of the calculation 

 
FIGURE 2 – Maximum height with indication of available sea level measurements (circle) and 

estimated heights on the coasts (rectangles) 

The comparison is performed by creating a “sensor” (see the box on the right) 
by left clicking with the mouse on any point of the calculation space. A green square is 
created indicating the point.  
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In order to establish a sensor exactly on the point where 
the measurements are located, right click on the sensor and select 
the option “Add a sensor at buoy” in the popup menu that will 

appear. A green square is created below the buoy location and the form of the buoy 
becomes a triangle. 

 
FIGURE 3 - Creation of a sensor at the buoy location 

In order to visualize the sea level at the sensor position 
you may click with the left mouse button on the sensor square in 
order to retrieve the sea level at that point. A first plot of the 
calculated sea level is shown on the screen; then right click on 
the buoy symbol (the triangle) and select the option “Add to Last 
Plot”. Now there are two possibilities: a) it is the first time this 
plot is performed or b) you already executed this operation. In 
the first case the programme will look in the local database to 
check if the data of this particular buoy for the requested time 
window. In case there is no data available the programme asks if 

you want to retrieve data from the GLOSS database of UNESCO (See 
http://www.ioc-sealevelmonitoring.org/ ) or from the DART database of NOAA 
(http://www.ndbc.noaa.gov/dart.shtml ) or whichever is the required source of the 
data. If the answer is yes the programme will connect with the source of the data and 
will request the synchronization of the current local database with the data available 
online. If the data exist on the source they are downloaded, stored in the local database 
and shown as overlay plot with the previous calculated trend obtained by the sensor. 

To resume, the following actions: 

 Open a new window 

 Type the folder http://tsunami.jrc.it/model/swan/Reports/2371 

 Press the “Show” button 

 Go to the Max Height window and create a sensor a one buoy 
location 

 Click on the sensor green rectangle and create the basic plot 

 Right click on the buoy triangle and add the measurement to the 
calculated value 

will create a plot like this: 
 

A sensor is a 

“probe” of the calculation 
that allows retrieving the 
calculated value at that 
particular location. The 
programme establishes the 
required cell and from that 
cell extract the quantity 
needed (height or water 
velocity). 

It is better  to 

include first the calculation 
result and then the sea level 
measurement because the 
first one is exactly on the 
time window needed for 
analyzing the event. 
Requesting first the 
measured quantity the 
system will show all the 
recorded data and it is more 
difficult to search the exact 
time window of the event . 

http://www.ioc-sealevelmonitoring.org/
http://www.ndbc.noaa.gov/dart.shtml
http://tsunami.jrc.it/model/swan/Reports/2371
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FIGURE 4 – Basic comparison plot of a calculated and measured quantity 

 

The plot above, FIGURE 4, shows the comparison of the sea level measured 
on the DART located 690 NM (Nautical Miles) South East of Tokyo with the same 
quantity estimated by the calculation. The Blue curve is the calculated quantity and 
shows an increase of the sea level delayed respect to the measurement.  
 

It is possible to double click on the top axis, FIGURE 5,  to create a time mark 
(green square in the figure below) and moving the square by dragging and dropping the 
mouse it is possible to read the absolute time (7:12 AM), relative time (1h 26 min from 
the earthquake) and the values of the quantities in the plot at that particular time (1.11 
m and 0.01 m).  
 
 By right clicking in a white space around the plot, it is possible to visualize the 
characteristics of the plot, FIGURE 6 and thus change the time limits, the plot 
min/max, the size of each curve, to include a multiplication factor for the values or for 
the time, an x or y offset and other important factors that will be described in the 
Filtering Data section, later in the Manual. 
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FIGURE 5 - Identification of relevant times and values 

 
FIGURE 6 – Plot characteristics 

When the plot characteristics window is shown, in the main menu an additional 
“Options” label appears where it is possible to select, among other, a different type of 
time units, such as minutes or hours and the plot changes accordingly when saving the 
new characteristics, FIGURE 7. 

  
FIGURE 7 – Changing the Time Unit in Hours from the event 
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DATA FILTERING 

It is important to apply the right filtering to the data in order to get 
the right Tsunami behavior from the measured quantities 

he signal of a Tsunami event has to be deduced by an overall sea level which 
contains a low frequency component corresponding to the tidal wave plus 
other higher frequencies due to other local or regional phenomena. The tidal 

component could be estimated using several methods such as ephemerid components 
which however are not known apriori in all locations in the world. There are some 
programs that calculate the tide, such as xtide32 but they need to be initialized with the 
local conditions which often are not identical to the ones that is needed at the location 
of the tide gauge. In addition, very often the forecast points never coincide with open 
sea where also is necessary to estimate the tide. 
 TAT uses various methods, more or less complicated, to remove the tide 
component and get the right value for the Tsunami signal. In particular the following 
methods are used: 

 Moving average 

 3 points filtering 

 FFT 

 Xtide32 tide removal 

Moving Average method 

This method consists in recalculating each point 
as the difference between the signal and the 
average between a number of points before and a 
number of points after the current one: 

Vi=Vi-Average(Vi, i-N, i+N) 
The number of points depends on the acquisition 
frequency. Typical values are 60-80 for DART 
measurements and 20-30 for tidal gauges. 
The number of points can be changed by the user (Figure 8) that can change the 
default value, stored in the local database. By specifying a value of -1 the “real” signal is 
shown, without any tidal correction; a large negative number (e.g. -60) will show the 
real signal averaged with N points before and after the current one: 

Vi=Average(Vi, i-N, i+N) 

Chapter 
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Figure 8 – The moving average is activated 
by selecting the number of points in the 

average 
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FIGURE 9 – The same quantity of previous figures with different number of points for the average 

The above figure shows the effect of increasing the moving average number. From the 
curves it is possible to note that with 20 points there is a large initial decrease before the 
large excursion while with 20 or 100 the maximum value is almost the same . A further 
increase of the number of points does not change substantially the curve but it is better 
not to increase too much this number or the curve can become totally flat. 

 
FIGURE 10 – Use of post average averaging procedure (brown curve is with 100 points of Moving average while the in the red 

curve the residual has been further averaged with 10 points. 
  

3 POINTS Filtering 

The Moving average method is very fast for a quick evaluation but it requires 
testing the number of points for the average to avoid to cut too much the real signal. 
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The 3 points method has been established from the consideration that looking at the 
“real” signal (with -1 as moving average), it is relatively easy to identify the long tidal 
wave behavior and therefore establishing a second order polynomial curve that 
represents the tidal gauge is easy and can be removed from the real signal to obtain the 
Tsunami signal. 
   

 
FIGURE 11 – The real curve with the indication of the 3 points that will be selected for the polynomial curve 

 

FIGURE 12 – The red curve obtained from the 3 points selected 

As an example in the same example previously indicated the real signal is the 
one in FIGURE 11, where 3 points are selected: before the event, close to the main 
peak and at the end of the period. The red dotted curve in FIGURE 12 is the resulting 
polynomial curve that is removed to the real value to obtain the true Tsunami signal. 
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FIGURE 13 – The brown thick curve is the one obtained with 3 points filter, the red one is obtained with 100 points Moving 

average 

As it can be seen by the FIGURE 13 the trend is comparable 
with the 100 points moving average. The only exception is at the 
borders where there is a deviation which was also visible in the 
dotted curve of FIGURE 12. 
This method is particularly useful with tidal gauges which in 
general have a much lower acquisition frequency and therefore 
sometimes the moving average is unable to work properly. 

FFT Method 

This method aims at establishing a low pass and high 
pass cut filters on the Fast Fourier Transformation (FFT) on the 
curve and reconstruct it using the remaining part of the 
components in the frequency domain. The FFT is a method to 

find the coefficient of the Fourier series approximating a curve. The coefficients 
represent the weight of each cosinus or sinus series component of increasing frequency 
that, once rebuilt, allows to approximate the curve. Every point in time can be 
expressed as  

 
Y(t)=a0+Σi(ai*cos(2π*i*t/ΔT) + bi*sin(2π*i*t/ΔT)) + ε 

 
Where ΔT is the time interval min max in which interpolation is obtained. Considering 
that the tidal component is a long period component in the order of at least 4 h while 
the level change due to the Tsunami has a shorter period of about 10-15 min, it is 
possible to apply at the same time a high pass filter to remove the tidal component and 
a low pass filter to remove the noise on the signal. The filtering is performed 

The 3 points 

filtering method is 

better respect to the one 
with the moving average 
because it does not cut 
frequencies to the signal. 
However it is a bit more 
time consuming (change 
visualization mode, selecting 
the points, redraw). 
Therefore it is generally used 
in order to validate the 
Moving Average method 
and check the correct 
number of points to 
perform the average. 
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considering only the components of the series whose frequency is within the required 
filter band. 
 

FIGURE 14 shows the power spectrum of the curve of the examples above. By 
selecting a high pass filter period at 1h (f=0.00027 Hz) and low pass filter period at 6 
min (f=0.0027 Hz), the resulting curve is compared with the moving average at 100 
points in FIGURE 15. It is possible to see that the filter is able to remove almost 
completely the initial peak due to the earthquake and shows a considerably smooth 
trend in the rest of the curve. However the maximum peak is slightly reduced. 

  
FIGURE 14 – Power spectrof the curve: left without filtering, right filtering high pass filter at 1h (0.00027 Hz) and 6 min (0.0027 

Hz) as low pass filtering 

 

 
FIGURE 15 – Resulting curve after application of FFT filtering (blue curve) compared with the Moving average with 100 points 

 

Xtide32 tide removal 

This method aims at calculating the real tidal component using an external 
programme (xtide32, http://www.wxtide32.com/ ). The algorithm that XTide 

http://www.wxtide32.com/
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uses to predict tides is the one used by the National Ocean Service in the U.S. 
XTide reads these data from harmonics files. These harmonics files are not available 
everywhere and therefore the method is correctly and successful only in some 
locations of the world. Where a location does not exists a procedure allows to try 
to estimate and adapt the tide evaluation to the measured trend. 

The tide removal method is particularly useful when the Tsunami 
phenomenon extends over one or two periods (ex. Analysis of Tropical Cyclones 
data) because in this case the previous methods (moving average or 3 points filter) 
do not work properly. In addition this method is useful to estimate values at the 
coast because most of the locations present in xtide database are ports at the coast; 
as a consequence this method should not be used for DART buoys which are 
offshore. 

 
FIGURE 16 – The brown curve is the real signal and the blue curve is the calculated tide 

 
 The example of the above figure is related to a location, Omaezaki (or 
Omae Saki), located at lat/lon 34.6/138.23 for which there is a prediction location 
in the xtide database, which is not always the case however. As it can be seen the 
prediction is fine but there is a slightly offset in the curve which would lead to a 
positive component of the signal even before the event. Therefore a procedure 
has been included which consists in selecting one minimum and one maximum of 
the measured signal; the programme will then use the times to include a time 
offset and an offset and a multiplication factor to take into account the different 
amplitude (e.g. the curve is forced to pass through the 2 minimum and maximum 
points). The result is that it is so possible to have a better residual curve (see 
FIGURE 17). 
 

http://oceanservice.noaa.gov/
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FIGURE 17 – The brown curve is the real signal and the blue curve is the calculated tide corrected with the 2 points procedure 

while the pink curve is the residual, the difference among the two curves. 

 

 
FIGURE 18 shows the various possible options that 
can be selected, as described in the previous 
paragraphs. 

 
 
 

 

 
FIGURE 18 – Possible options included in 

the menu for each quantity 
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Sea Level Database and 

Synchronizing strategies 

This section describes how to keep updated the sea level database 
and how to synchronize their data 

 
FIGURE 19 – Current distribution of sea level network that can be used to understand the sea level behavior during a Tsunami  

 
n important component in the Tsunami analysis is the on line availability 
of sea level measurements. The two most important sources of 
information for these quantities are: the network of DARTs (Deep-
Ocean Analysis and Reporting on Tsunamis, 
http://nctr.pmel.noaa.gov/Dart/) from NOAA and the Sea Level 
Monitoring Facility (http://www.ioc-sealevelmonitoring.org/), in the 

frame of the GLOSS programme from UNESCO. 
 The DART network is a series of deep Ocean pressure sensors located 
offshore in strategic positions to catch the initial Tsunami waves and be able to give 
indication on the sea level in open sea. These are particularly important because they 
allow an easy comparison with the calculated quantities from codes and thus allow to 
judge about the correct definition of the fault parameters. NOAA uses the DART 
network in order to identify the “real” deformation and thus forecast the prediction to 
the coasts using a novel technique1.  

                                                                        

1 When a tsunami event occurs, the first information available about the source of the tsunami is based only 
on the available seismic information for the earthquake event. As the tsunami wave propagates across the 

Chapter 

4 

A 

http://nctr.pmel.noaa.gov/Dart/
http://www.ioc-sealevelmonitoring.org/
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 The GLOSS network is aimed at collect and 
disseminate data related to real time sea level tidal 
gauges. Initially it was focused on operational 
monitoring of sea level measuring stations in Africa 
and was developed from collaboration between 
Flanders Marine Institute (VLIZ) and the 
ODINAFRICA project of IODE. The system has 
been expanded to a global station monitoring service 
for real time sea level measuring stations that are part 
of IOC programmes i.e. (i) the Global Sea Level 
Observing System Core Network; and (ii) the 
networks under the regional tsunami warning 
systems in the Indian Ocean (IOTWS), North East 
Atlantic & Mediterranean (NEAMTWS), Pacific 
(PTWS) and the Caribbean (CARIBE-EWS).  
 
 Other sources of information may be 
included in the list of possible real time data. At the moment of writing we included 
also 

 Sea level measurements from Portugal 

 Sea level measurements from Turkey 

 Sea level measurements from Italy (ongoing) 
Some of these sea level measurements are already included in the GLOSS system but 
due to bilateral agreement with JRC it is possible to access higher frequency data or get 
a more frequent update, and thus reducing the time delay. 
 FIGURE 19 shows the current distribution of sea level sensors that can be used 
during a Tsunami event. The list is contained in the local database and in the server 
database (see later) and can be automatically or manually updated as there are new 
devices available. 

                                                                                                                                                                                              

ocean and successively reaches the DART® systems, these systems report sea level information 
measurements back to the Tsunami Warning Centers, where the information is processed to produce a new 
and more refined estimate of the tsunami source. The result is an increasingly accurate forecast of the tsunami 
that can be used to issue watches, warnings or evacuations 

FIGURE 20 – The first operational 

DART® buoy system design is shown in the 
photograph on the left (NOAA web site) 
 

http://nctr.pmel.noaa.gov/Ship_time/Images/dart_brown.jpg
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Data Storage location and working modes 

TAT has two methods for storing and accessing the data of the sea level: on the local 
computer or on a server accessible via internet. 
Local Database 

The TAT uses an Access Database named tsvis.mdb and located 
in the subdirectory /DB in the installation directory. This 
database contains several tables that are needed for the working  
BuoyData and as it can be guessed contain: the location and the 
characteristics of each sensor and the data points that are read 
online from the various providers.  
Online Mode 

In this mode the database is located in Ispra and a procedure 
automatically reads the sea levels from the related sources and 
store the level data on a SQL server database. The access from 
TAT is performed via a web service which provides the data 
within a specified interval for any particular sea level gauge 

Data Syncronization 

The synchronization of the tide gauges, in the case on Local 
database is performed by activating the sync procedure. This can be activated for all the 
sea level gauges or only for the sea level gauges in the window that is being analysed or 
only for a special gauge. The sync can be manual or automatic at an interval of 5 min.  

S Y N C  A L L  T H E  G A U G E S  

The automatic sync of all the tidal gauges is performed by 
selecting the option Tools>Buoys>Sync. A window open where a 
command “Sync now” is present. The pressing of this command 
performs only one sync of all the tidal gagues. A check box, 
identified by the label “Activate timer” allows to perform a 
periodic sync at an interval indicated on the same window; the 
interval can be modified by the user. 

S Y N C  B U O Y S  I N  T H E  A N A L Y S I S  W I N D O W  

When an analysis in performed and a window is open, as 
described in the chapter 2, in which only a limited number of 
tidal gauges is shown, the option that is activated with the 
menu “Options>Sync buoys in window” allows to sync only the 
gauges in the window and no other gauges that may be not 

interesting. 
S Y N C  O N L Y  O N E  B U O Y  O F  I N T E R E S T  

This can be done in two ways: by clicking the right button of the mouse over one buoy 
and selecting the menu item Sync buoy or, when plotting a sea level, by selecting in the 
plot options window, the item labeled as “Auto sync buoys”. With this option all the 
buoys that have been plotted are periodically synchronized. Therefore using this option 
in connection with “Auto refresh” option in the same menu item, it is possible to 
continuously update a plot with always new data. 

Update of List of Buoys 

The list of available buoys change from time to time and sometimes some of the buoys 
become obsolete and useless when analyzing an event. Therefore periodically (once a 

Local or 

Online mode ?  The 

Local method has the 
advantage that the database 
is always available even  if 
there is no internet 
connection. This method is 
particular useful for off-line 
checking of events. 
However in this case it is 
necessary to synchronize   
The Online mode means 
that all the gauges are 
synchronized by a dedicated 
procedure and there the data 
can immediately be used. As 
the network is not available 
the comparison is no longer 
possible. 

Auto sync in a 

parallel instance   

If you prefer to adopt the 
local database to store and 
retrieve the sea level data, it 
may be a good practice not 
to use the current TAT 
programme for a continuous 
sea levels sync because it 
may interfere (slow down) 
the programme itself. Its 
better instead to launch 
another instance of the 
programme that keep 
updating the database so 
that the data are already 
updated when needed. 
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month) it is a good practice to check if there are new sensors being published by 
NOAA or by GLOSS. 
This is performed by selecting the item  Tools>Buoys>Update List.  The programme 
connects with the relevant sites and presents a list of new sensors. In the resulting 
window a button allows to update the list automatically. 
It is also possible to manually update the list of sensors by adding a new row to the 
table BuoysLocations in the tsvis.mdb database. 
This is an example of record in this table 

buoysLocations 

I
D 

lat Lon 
latDeg

Min 

lonDeg
Min 

name 
stat
us 

group
ID 

fileTy
pe 

sens
or 

filename 
Not
es 

Onli
ne 

X 
Multiplicat
ion Factor 

Y 
Multiplicat
ion Factor 

X-
offs
et 

Y-
offs
et 

MovAvg
Np 

Lab
el 

6
5 

-
5.36

33 

165.04
67 

5° 21' 
48" S 

165° 2' 
48" E 

Station 
52406 - 
450 NM 
Northeas
t of the 
Guadalca
nal 

activ
e 

2 DART  http://www.ndbc.noaa.gov/data/realtime
2/52406.dart 

  1 1 0 0 20  

 
This is the explanation of the various fields 

 ID: don’t fill, is an automatic number. All the acquired data contains this as BuoyID 

 Lat: latitude in decimal degrees 

 Lon: longitude in decimal degrees 

 latDegMin: If you do not know Lat in decimal degrees, you can insert here the latitude in 
the following form:  D° mm’ ss” S/N, example 5° 21' 48" S 

 lonDegMin: same as above with the exception to write E or W for east or west 

 name: description of the sensor 

 status:  active or inactive 

 groupID: this is a number that has a correspondence in the Groups table, see later 

 fileType: indicates the form of the data see after 

 sensor: ignore, future use 

 filename: this can be a filename or an internet address containing the data in the form 
specified by fileType 

 Notes: free text 

 Online: yes or no 

 X Multiplication Factor: the time data read are multiplied by this factor (default 1) 

 Y Multiplication Factor: the value data read are multiplied by this factor (default 1) 

 X-offset: the time data are moved by this factor (default 0) 

 Y-offset the value data are moved by this factor (default 0) 

 MovAvgNp: this is the default vale for the Moving Average filtering procedure (see previous 
chapter). The normal for tidal gauges is 20, for DART is 60. Indicate -1 if you want to see 
the real data, without filtering 

 Label: this is a label appearing as Y label. If null it is Level (m) 
 
The possible formats of the data are the following: 
 

AZO TD: Azores University data 

BOM: Bureau of Meteorology Data, Australia 
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DART: NOAA DARTs 

GITEWS: used for a specific sensor in Indonesia 

GLOSSxml: common method by GLOSS, XML format 

PT TD: format for Portugal sea levels 

SET: format for Setubal buoy 

TAD_P: format for Tsunami Alerting Device, pressure curve 

TAD_T: format for Tsunami Alerting Device, temperature curve 
TR: Turkey sea level sensors 
 
 

It is always possible to add new buoys manually but one of the above formats has to be 
specified. If the format is another one, you need to contact JRC for an update of the 
software after specifying the required format. 
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Seismic Events Collection 

This section explains how to collect automatically data seismological 
data from various sources 

AT contains a section that allows to monitor ongoing seismic events that 
may be the ones that are then analysed for a potential Tsunami. By 
selecting the option Tools>Seismic Events the window below will appear 

reporting the timeline of the seismic events. 

 
FIGURE 21 – The seismic events window in TAT 

 
In order to update the list of events, it is necessary to activate the item Scraping>Enable 
Scraping and the system will start collecting the events by connecting with the sources 
that are defined in the tsVis.mdb database, table Seismic Feeds. From this moment 
every 5 min a new check is performed or it is possible to use the option Scraping>Scrape 
Now! If you want to execute immediately the scraping of the events. 
 
It is possible to add new seismic feeds but the format has to be agreed with JRC that 
has to provide the right interface to read the data. At the moment we are using the 
following sources of information: 
 

Seismic Feeds 

name URL 

NEIC http://earthquake.usgs.gov/eqcenter/catalogs/eqs7day-M2.5.xml 

EMSC http://www.emsc-csem.org/index.php?page=current&sub=list 

INGV http://cnt.rm.ingv.it/~earthquake/index_web_cnt.php 
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Seismic Feeds 

name URL 

BMG http://www.bmg.go.id/dataxml/gempaterkini.xml 

GEOFON http://geofon.gfz-potsdam.de/db/eqinfo.php 

JMA http://www.jma.go.jp/en/quake/quake_local_index.html 

IRIS http://www.iris.edu/seismon/last30.html 

IM_push http://www.gdacs.org/earthquakes/push.asp?mode=rss&source=IM 

EMSC_push http://www.gdacs.org/earthquakes/push.asp?mode=rss&source=EMSC 

 
In some cases the scraping page is an XML file while in other cases (ex. JMA) it is a 
web page and it is necessary then to navigate in further links to get all the required 
information. 
 
Double clicking on one of the events the following window opens which has a number 
of tabs and this represents the starting point when analyzing a totally new event.  
The left window contains the event characteristics and shows if there is an event in the 
scenario database that can represent it. If you want to check this event you should click 
on “Open” and the results of the scenario database are shown. 
 
By selecting the tab labeled “Seismic Matrix” the evaluation of the event using IOC 
type of matrix is presented. For the event below, for example (M7.1, Off East Coast 
Of Honshu of 10 July 2011 00:57:08) the seismic matrix foresees a Tsunami Watch 
/Warning. 
 

   
FIGURE 22 – The seismic events analysis 
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FIGURE 23 – The bulletin creation 

 
By selecting the tab labeled “Msg Creation” a bulletin is created depending on the type 
of requested information (Information or Advisory, etc). The parameters to compose 
the message are obtained by the event window and by the forecasted points window. 
The text of the message is configurable and is contained in the tsVis.mdb database, 
table Options, keywords InfoMsg and AdvisoryMsg. 
 
In the InfoMsg and AdvisoryMsg there are keywords that represent information for 
the message 
 
$TIME_MSG$ : current date of the message 
$LIST_CALC$:  list of locations and forecasted height 
$MAGNITUDE$ : magintude of earthquake 
$TIME_EVENT$:  time of the event 
$LAT_LON$ : latititude and longitude 
$LOCATION$ : textual information on the location 
$DEPTH$ : earthquake depth 
 

A sample message composed with the information above for the previous event, 
takes the form below. From the window it can be cut and pasted in real bulletin, 
adjusted in the text and sent out via email or other alerting messaging system. It is 
a quick way to facilitate the preparation of the bulletin.  
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TSUNAMI MSG No. xxxxx  

 

TSUNAMI SEISMIC ADVISORY MESSAGE 

NEAMTWS NORTH ATLANTIC REGIONAL CENTER, INSTUTUTE OF METEROLOGY, LISBON 

$DATE_MSG$ 

 

...THIS IS AN ADVISORY MESSAGE... 

 

TSUNAMI ADVISORIES MEAN THAT A TSUNAMI CAPABLE OF PRODUCING STRONG 

CURRENTS OR WAVES DANGEROUS TO PERSONS IN OR VERY NEAR THE WATER IS 

IMMINENT OR EXPECTED.  SIGNIFICANT WIDESPREAD INUNDATION  IS NOT EXPECTED 

FOR AREAS UNDER AN ADVISORY.  CURRENTS MAY BE HAZARDOUS TO SWIMMERS... 

BOATS... AND COASTAL STRUCTURES AND MAY CONTINUE FOR SEVERAL HOURS AFTER 

THE INITIAL WAVE ARRIVAL. 

 

RECOMMENDED ACTIONS 

A TSUNAMI HAS BEEN GENERATED WHICH COULD CAUSE DAMAGE TO THE WARNING 

AND/OR ADVISORY REGIONS LISTED IN THE HEADLINE. PERSONS IN LOW-LYING 

COASTAL AREAS SHOULD BE ALERT TO INSTRUCTIONS FROM THEIR LOCAL EMERGENCY 

OFFICIALS. EVACUATIONS ARE ONLY ORDERED BY EMERGENCY RESPONSE AGENCIES.  

 

 - PERSONS IN TSUNAMI ADVISORY AREAS SHOULD MOVE OUT OF THE WATER… OFF THE 

BEACH AND OUT OF HARBORS AND MARINAS. 

 

THIS MESSAGE IS BASED ON EARTHQUAKE DATA… OBSERVED TSUNAMI AMPLITUDES… 

HISTORICAL INFORMATION AND FORECAST MODELS. 

 

A TSUNAMI HAS BEEN OBSERVED AT THE FOLLOWING SITES 

 … or … if based on calculations  

A TSUNAMI IS FORESEEN AT THE FOLLOWING SITES 

 

LOCATION                   LAT    LON     TIME        AMPL 

------------------------  -----  ------  -------     ----------- 

KAMAISHI - JAPAN          39.2N   141.8E 12:57 UTC   0.2M/0.6F   

OMOTO - JAPAN             39.8N   141.9E 12:57 UTC   0.2M/0.6F   

YAMADA - JAPAN            39.4N   141.9E 12:57 UTC   0.1M/0.3F   

KESENNUMA - JAPAN         38.8N   141.6E 12:57 UTC   0.2M/0.6F   

KUJI - JAPAN              40.1N   141.8E 12:57 UTC   0.1M/0.3F   

MINATO - JAPAN            38.7N   141.5E 12:57 UTC   0.2M/0.6F   

 

 

TIME - TIME OF MEASUREMENT OR CALCULATION 

AMPL - TSUNAMI AMPLITUDES ARE MEASURED RELATIVE TO NORMAL SEA LEVEL. 

IT IS …NOT… CREST-TO-TROUGH WAVE HEIGHT. 

VALUES ARE GIVEN IN BOTH METERS(M) AND FEET(FT). 

 

PRELIMINARY EARTHQUAKE PARAMETERS 

 MAGNITUDE - 7.1 

 TIME      - 0057 UTC SUN JUL 10 2011 

 LOCATION  - 38.06 NORTH 143.33 EAST 

             OFF EAST COAST OF HONSHU 

 DEPTH     - 10.0 KM 
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Current Calculations by 

JRC and NOAA 

This section explains how to access and analyse online events 
hen a new event occurs the GDACS system or other online systems can 
activate a calculation in the JRC online system. It is therefore possible to 
analyse these events while the calculations are still ongoing. Similarly NOAA 

publishes a list of “solutions” from their database that can represent the ongoing event 
based on seismic parameters; in some cases they also publish the “real” solution based 
on the analysis based on the inversion technique, see later. 
 

JRC Online calculations 

The calculations are triggered by the GDACS system or by a web server in which 
several data providers (USGS, EMSC, Portuguese IM, Turkey Kandilly) write their data 
and can trigger a new calculation. 
The list of available calculations is obtained by selecting Tools>Current Calculations. All 
the requested calculations are listed in order of request; which means that for one event 
there may be 5-10 calculations depending on the evaluation and the estimate made by 
the various organizations. 

 
FIGURE 24 – The list of performed calculations 

In order to select one calculation you need to double click on the line representing it. A 
window of analysis is open and you can use all the features explained in Chapter 2 to 
analyse the event. 
Once an analysis window is open and you want to use this window (and not for 
example the one coming from the scenario database) as basis for the issuing of the 
alerting bulletins, you should press the menu item “Set this as event calculation”. 
The online calculations are performed automatically with the conditions estimated by 
the seismological organizations. It is always necessary to compare them with the real 
online measurements available in order to judge how the initial conditions in the 
calculations are representative of the real conditions. 
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NOAA unit source scenario results 

During the analysis you can compare the calculated quantities with the sea level. Also 
you can compare the calculations for the same point with an equivalent value estimated 
with the NOAA unit sources analyses. This is a method developed by V. Titov from 
PMEL/NOAA that consists in the approximation of the real deformation source as a 
series of “unit source” each one being 100km x 50 km of unitary height. Each of this 
corresponds to an earthquake of about 7.5 magnitude. Composing various sources and 
identifying the multiplication factors per each source, it is possible to simulate greater 
events or smaller events (e.g. one source with multiplication factor lower than 1). 
In the logic of the Tsunami forecasting (http://nctr.pmel.noaa.gov/propagation-
database.html ), it is then possible to “invert” the solutions by comparing them with 
the measured DART sea levels and obtain the “true” solution which consists in the list 
of factors that needs to be multiplied the selected unit sources to have the better 
agreement with the measured quantities. For example in the case of Tohoku 
earthquake of 11 March 2011 the “seismic” solution was represented by the following 
expression 

15.70*kiszz26+15.70*kisza26+15.70*kiszz27+15.70*kisza27+15.70*kiszy26+15.70*kiszy27+15.70*kiszb26+15.70*kiszb27 
which indicates that the sea level is obtained, for each point by the linear combination 
of the results of 8 unit sources, each multiplied by the factor 15.70 (m). The various 
unit sources are identified by the keywords kiszz, kisza, etc. 
After comparing this with the sea level measurements the resulting solution is the 
following 

4.66*kiszb24+12.23*kiszb25+26.31*kisza26+21.27*kiszb26+22.75*kisza27+4.98*kiszb27 

which shows a different list of sources and different factors for each of them.  
The list of solutions from NOAA is shown by selecting Tools>NOAA events.  

    
FIGURE 25 – The list of events in the NOAA site (left) and window to enter the 

specific source combination to analyse 
It is possible verify the result of the solutions by selecting one of the DART sensors, 
create a sensor at the buoy position and right click on the sensor specifying Add 
NOAA result; in the following window you should select one of the proposed 
solutions or write your solution yourself. In the figure below the DART value (brown 
curve) is compared with the NOAA seismic solution (red curve) with the solution 
coming from the inversion process (green curve). The NOAA unit sources solution 
should only be used off-shore because they have been obtained with a 4 min 
bathymetry which is not suitable close to the coast. 
 

http://nctr.pmel.noaa.gov/propagation-database.html
http://nctr.pmel.noaa.gov/propagation-database.html
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FIGURE 26 – Example of NOAA solution for the Tohoku earthquake at the DART 

named Pacific 690 NM Southeast of Tokyo 
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Simulation mode 

For Training purposes TAT allows to play an existing event to 
check the response of  operators. 

 
FIGURE 27 – Situation room during a Tsunami Analysis                                 

(European Crisis management Lab, JRC Ispra) 
f a Tsunami is a very unlikely event it is also true that is not very often. This means 
that the operators of an emergency center do not have many possibilities to put in 
practice their skills in the use of this programme. It is therefore important to 

organize simulation training sessions on a periodical basis. TAT foresees the use of a 
procedure that uses stored values for the measurements and the calculations that are 
slowly made available in order to simulate an ongoing event. 
 
The simulation mode is initialized by opening a new Analysis window and calling one 
event (scenario or online calculation, on the disk or online) and then selecting the item 
Options>Start Simulation Mode. The window represented below is open which allows to 
control the simulation. 
With reference to the FIGURE 28: 
 
Zero Time: is the time of the initiating event, cannot be changed 

Chapter 

7 

I 



 

 28 

 

FIGURE 28 – Simulation form 
 

 
FIGURE 29 – When the simulation starts the 
time shown in the analysis window shows the 
current simulated time and the simulated time 

from the event 
 

Accel Factor: is the factor accelerating the time. Any value can be used but 
a real event should have factor 1. To save time you can 
increase the factor to 5 or 10 times the real time. 

Start Time: In a real event the operators will start looking at the event 
after the identification of the earthquake, i.e. 10-15 min. This 
time is the time from which the simulation will start. The 
format is hh:mm. 

Refresh interval: It is the time in s for the refresh of all the curves (15 s or 30 s 
is fine) 

Calc/real time ratio: When comparing with a calculation this controls how fast the 
calculation is. In general during a real event the online 
calculations are executed with a calculation speed higher than 
real time. If this ratio is 2 it means that after 1h the 
calculation is already at 2 h simulation time. Using 1 or lower 
the calculation is equal or slower than real time (no 
forecasting). 

 
During the simulation mode, the 
use can perform any analysis 
operation that is possible in a real 
event, such as creating sensors, 
comparing with buoys sensors, 
zooming in the plots etc. The 
curves representing the buoys, 
however, are shown “as if” the 
time is advancing from the starting 
time, as indicated in the analysis 
window while the calculated 
quantities advance according to 
the current time eventually 
accelerated by the calc/real time 
ratio. 
 
When a situation of windows, 
limits and curves established is 
established, it is possible to save 
the simulation for further analyses 
by pressing the button Save 
simulation and reload it at a later 
stage with Load simulation. 
 
As it can be seen in FIGURE 30, 
the curves are updated only until 
the current simulated time (see 
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also FIGURE 29). It should be noted that the plots are not 
automatically refreshed, as it should be in a real case. In order 
to auto refresh you have to activate the option in the plots 
property page. 
 
One possible way of using the Simulation mode is that a 
trainer could establish a new case and the trainee should select 
the corresponding scenario and try to estimate the evolution of 
the event.  
 
Simulations or replay of past events are essential to be ready 

during the next event. 
 

 
FIGURE 30 – Simulation mode with some windows open 

 
 

Proper 

selection of 

simulation cases   

In order to perform a 
simulation session, it is 
better to use a case which is 
stored on the disk (i.e. 
scenario case or a dedicated 
analysis) instead of using an 
online calculation because 
the access time to the server 
can limit the simulation 
speed and makes the 
application less responsive. 
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Request  an online 

calculation 

It is possible to request an online calculation to the JRC system by 
specifying the initial conditions of  the event 

alculation of specific events may be requested online. In order to do so use the 
option: Tools>Request a calculation. An authentication form will be shown. User 
and password to access the calculation mode have to be requested to JRC. 

 

 
Figure 31 - Authentication form to perform online calculations 

The form below will open in order to collect the necessary data to perform the 
calculation. It is possible to specify a very limited number of information 
(lat/lon/mag/depth) and the system will automatically initialize the calculation with 
these data. In alternative it is possible to define the fault parameters (strike, dip, rake, 
width/length,slip) and the system will define the rest of the needed quantities (width of 
the calculation space, time step etc).  
 
The objective of this form is not to allow to perform a detailed calculation analysis but 
rather to give the analyst a simple tool to analyze a potential event. Therefore it is not 
possible to specify the width of the calculation or perform a nested approach. For this 
other tools should be available whose result may then be analysed with TAT if the 
output is conform to it. 
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Figure 32 – Data input form for the online calculation 

In principle it is also possible to select the code to perform the calculation; by default 
this is SWAN but other codes will be possible (option not yet available). 
The result of the calculation will be stored online and therefore it may be accessible by 
all users having TAT. 
 

This section is being developed. Therefore there are not so many details. It may change 
in the next future in terms of input and masks and the manual will be updated 
accordingly. 
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Scenario databases 

TAT relies on pre-calculated scenarios in order to have a quick 
estimate of  the event 

cenario databases are a series of pre-calculated events that can be called and 
analysed as well as compared with real data. At the moment JRC relies on a 
number of scenario databases built with different initial condition logic. During a 

real event, if the online calculations are not yet available, it is possible to search and use 
the scenario databases results as a first approximation of the real events. 
 

 
FIGURE 33 – Search window 

 
When opening TAT by default the search window is open. If closed during the 
operations, it is possible to reopen it by selecting Tools>Grid>Search grid. The window 
allows to specify Latitude, Longitude and Magnitude of the event. At the moment 
there are two possible choices for the scenario, the JRC 1.0 or the JRC/IM 2.0. Other 
scenarios will be added in the next months. The JRC scenario has a worldwide 
coverage and has been composed using simple cosinusoidal deformation, with a 
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maximum height established using a simple logarithmic formula, as indicated in 
Annunziato 2007. The JRC/IM scenario has been defined by JRC and Institute of 
Meterology (Portugal) and contain scenarios in the North Atlantic Region. 
 
Pressing the search button TAT search in the location specified in 
Options>Grid>Grid Location the closest event. For example, specifying 38.3/137.4 as 
Lat / Lon and magnitude 8.1 and searching in www.gdacs.org, the system will answer 
with the following text: 
 
Found a case: 

http://www.gdacs.org/tsunami/tsunamiGrid/DISK3/MAG_800/P1375^P0385^0800/ 

 

Latitude: 38.5 

Longitude: 137.5 

Magnitude: 8 

 
which indicates that one case close to the requested point has been found that can 
represent the requested case. By clicking on “Open new” the Analysis window below is 
open and it is possible to analyze the case as previously indicated for other analyses 
windows. It should be noted that the date assumed for the event is the current date 
which may be not representative of the case to be analysed; it can be changed by 
double clicking on the date and entering the right one. 
 
It is a current practice, when analyzing an ongoing event to open at the same time of 
an online calculation, also the corresponding scenario result because while the online 
calculation is going on, the scenario result is immediately available and can already give 
a first identification of the possible effects of the event. 
 

  
FIGURE 34 – Scenario analysis 

 
The location of the scenario database is specified by indicating the parameter 
GridDbDir in the Options table of the tsVis.mdb database. 
 

http://www.gdacs.org/
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Other features 

Other options and features are available in TAT. A brief  
description of  the main ones follow 

AT contains a section that allows to monitor ongoing seismic events that may 
be the ones that 
 

 
 Views 

 Views into Word 

 Export Locations 

 Travel times 

 Google Maps 

 Support for Hurricanes analysis 

 City Class filtering 

 

Views, Views into Word 

Once you have prepared your plots to follow an event, you may want to save this 
configuration in order to be able to recall it at a later stage. You may do this by using 
the command File>Save View  or File>Save View As to save the current arrangement 
to the same file used earlier or to change the file where to save. 
The views are saved in a text file that can also be modified. An example of this file is 
give below. It is possible to see that every curve. FIGURE 35 shows two plots that 
have been created by the procedure indicated below. 
It should be noted that the procedure stores also the absolute file paths of the 
calculations and if these are moved or deleted they are not found any more. 
In order to open a view you should use the command File>Open View. The 
command File>Open >Word will open a view and then export all the screenshots in a 
Word document. You may also create very long procedures to recreate or send to a 
Word document several plots with just one command. 
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* plot n. 1 

plot 

  

plotdef|SENSOR=040.17775|144.00054|Sensor||403|310|D:\JRC_Work\TsunamiCases\Japan_11032011\

Auto calculations\104706\coarse\|11 Mar 2011 5:46:23|1.0|1||1| 

  xmin 11/03/2011 3:00:00 AM 

  xmax 11/03/2011 12:00:00 PM 

  ymin -0.0603257940667681 

  ymax 0.10054299011128 

  chartTitle Wave Height at (lat/lon): 040.17775/144.00054 

  window 560 250 771 6 

endplot 

* plot n. 2 

plot 

  plotdef|SENSOR=38.70625|148.665|Buoy 

Sensor||527|349|D:\JRC_Work\TsunamiCases\Japan_11032011\Auto calculations\104706\coarse\|11 

Mar 2011 5:46:23|1.0|1||1| 

   *BUOY=25 

   buoyID|25|| 

  xmin 11/03/2011 3:00:00 AM 

  xmax 11/03/2011 12:00:00 PM 

  ymin -1.5081448516692 

  ymax 2.01085980222561 

  chartTitle Buoy readings DART Pacific 450 NM Northeast of Tokyo, Japan 38.70625/148.665 

(25) 

  window 561 278 772 256 

endplot 

 

FIGURE 35 - The procedure that will recreate the configuration of plots illustrated in the figure at the top 

Export Locations, Filtering 

When you have an analysis window open and you are analyzing the Locations (pressing 
the Locations tab), you may want to export the list of the locations in a CSV (Comma 
Separated Values) text file that can be then open in EXCEL for further analysis or 
filtering. 
Looking at the Locations list it is possible to click on the color of the alert in order to 
show only locations in which the alert level is at least that one (ex. All RED alert 
locations). You may obtain the filtering by clicking once on the alert color, double click 
to remove filtering. 
By clicking once on the country you will filter on that value. By clicking on the city 
class (1=large city… 6) you can visualize only locations with class value lower than 
that. 

Travel times 

An important simple feature is the evaluation of the travel time between 2 points. 
During an analysis by right clicking on 2 points on the map, you will get the distance in 
km and the expected travel time between the 2 points. If there is an island in between 
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the calculation of the time is not performed. The calculation is performed using the ray 
tracing method. 
 

 
FIGURE 36 – Travel time between 2 points 

 
Once the two points of the travel time are drawn on the picture, it is possible to right 
click the green squares and you can plot the height distribution of the bathymetry or of 
the sea level. 

 
FIGURE 37 – Sealevel height between the 2 points indicated in the previous figure 

 
 

Google Maps 

A recent inclusion is the possibility to see the list of buoys and the locations through a 
Google Map which allows to zoom up to very small values, use satellite images as 
background etc, but this is still  in progress and will be better described at a later stage. 

The distance between these 2 
points and the travel time 
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Support for Hurricanes analysis 

Also this is a new option that is aimed at analyzing the results of Hurricane calculations. 
Recently at JRC we are using a Tsunami code (HYFLUX) to analyse the storm surge 
caused by Tropical Storms, Hurricanes or Typhoons. The output of the code is similar 
to the one of a Tsunami and therefore we use the same analysis tool. In order to 
support this activity few options have been implemented just for that. 
In particular in the analysis window, by activating Options>Hurricanes>Load Track 
the file hollandData.txt is searched that contains the track points with wind gust and 
min. pressure and is visualized on top of the maximum sea level. 
In general the comparison of sea level for an hurricane needs absolutely the use of the 
tidal removal option because in contrast with the Tsunami, the hurricane lasts for 
several days and therefore any other filtering method does not work. 
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Conclusions 

 
This manual is in continue evolution but it represents the updated information in 
order to allow the users to perform the basic operation of the Tsunami Analysis. 
In the future it will be updated in order to reflect the new options that will be 
included in the software.  

Chapter 

11 



 

 40 

REFERENCES 

 
[ 1]  Annunziato, A., 2007. The Tsunami Assessment Modelling System by the Joint Research 

Centre, Science of Tsunami Hazards, 26(2), pp 70-92 

 
 
 
 
 
 
  



 

 41 

APPENDIX A – Minimum Required Files for TAT 

 
This section describes which files are necessary for creating output that are 
compatible with TAT. 

1 Locations.xml Compulsory 

2 Base.jpg Compulsory 

3 P1_MAXHEIGHT_END.jpg Compulsory 

4 Outres1.gif Optional 

5a Timeline files in netcdf 

 NETCDF_H.nc 

 NETCDF_U.nc 

 NETCDF_V.nc 

 

 Compulsory 

 Optional 

 Optional 

5b Timeline files in geoTif 

 Listfiles.txt 

 TIF_H_nnnnnnnn.tif 

 TIF_U_nnnnnnnn.tif 

 TIF_V_nnnnnnnn.tif 
 

 

 Compulsory 

 Compulsory 

 Optional 

 Optional 

6 Bathymetry.tif Optional 

7 WPFiles.tar 
WTFiles.tar 

Optional 

 
1. Locations.xml 

 
This is an xml file in a RSS extended format containing information on the 
epicenter and calculation details and a list of locations reached by the wave with 
their information. 
 
The basic form of the file is 
<rss> 
<channel> 

<item>     <!—the first item is the epicenter and fault info  
… 
</item> 
 
<item>   <!--  all the items after the first one are the locations reached-> 
.. 
</item> 
….  Several items 
 
</channel> 
</rss> 
 
An example of file with 2 items is presented here 
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<?xml version="1.0" encoding="ISO-

8859-1"?> 

<rss version="0.91" 

xmlns:geo="http://www.w3.org/2003/01/g

eo/wgs84_pos#"> 

<channel> 

<item> 

<title><![CDATA[]]></title> 

<description> 

Longitude=142.4&lt;BR&gt; 

Latitude = 38.3&lt;BR&gt; 

Magnitude =9.00&lt;BR&gt; 

Water Depth    =   0&lt;BR&gt; 

</description> 

<image>/P1_MAXHEIGHT_END.jpg</image> 

<location></location> 

<geo:lat> 38.3</geo:lat> 

<geo:long>142.4</geo:long><depth></dep

th> 

<dc:subject 

xmlns:dc="dc">EPICENTER</dc:subject> 

<pubDate>11 Mar 2011 5:46</pubDate> 

<link></link> 

<initialConditions> 

    <Fault><Lenght> 501</Lenght> 

     <Width> 140</Width> 

       <Height>12.65</Height> 

       <Form>8</Form> 

       <Magnitude>9.000000</Magnitude> 

       <Mode>0</Mode> 

       <Angle type="trig angle: 

north=90, south=-90">263.0</Angle> 

       <okadaPar> 

          <strike type="geogr angle: 

north=0, south=180">187.0</strike> 

          <dip>14.0</dip> 

          <rake>68.0</rake> 

          <depth>32.0</depth> 

          </okadaPar> 

   </Fault> 

   <Bathym>7.250000</Bathym> 

   <window> 

       <lonmin>98.768997</lonmin> 

       <lonmax>185.768997</lonmax> 

       <latmin>-5.178001</latmin> 

       <latmax>70.000000</latmax> 

   </window> 

   <dtMax>7.250000</dtMax> 

</initialConditions> 

</item> 

 

 

--: follows in the next column 

 
 

<item> 

<title><![CDATA[Japan: Inuwaka (2.04 

m)]]></title> 

<description><![CDATA[Country: Japan 

Location: Inuwaka 

Time (hh:mm): 00:00 

Maximum Height: 2.044883 m 

Time Max (hh:mm): 02:42 

]]></description> 

<pubDate>11 Apr 2011 06:46:00</pubDate> 

<cityName>Inuwaka</cityName> 

<country>Japan</country> 

<maxHeight>2.044883</maxHeight> 

<timeMaxH>02:42</timeMaxH> 

<timeArrival>00:00</timeArrival> 

<cityClass>5</cityClass> 

<popEst>-1</popEst> 

<geo:long>140.858505</geo:long> 

<geo:lat>35.697960</geo:lat> 

<dc:subject 

xmlns:dc="dc">2</dc:subject> 

<cputime>9</cputime> 

</item> 

<item> 

<title><![CDATA[Japan: Tokawacho (2.04 

m)]]></title> 

<description><![CDATA[Country: Japan 

Location: Tokawacho 

Time (hh:mm): 00:00 

Maximum Height: 2.044883 m 

Time Max (hh:mm): 02:42 

]]></description> 

<pubDate>11 Apr 2011 06:46:00</pubDate> 

<cityName>Tokawacho</cityName> 

<country>Japan</country> 

<maxHeight>2.044883</maxHeight> 

<timeMaxH>02:42</timeMaxH> 

<timeArrival>00:00</timeArrival> 

<cityClass>6</cityClass> 

<popEst>-1</popEst> 

<geo:long>140.856186</geo:long> 

<geo:lat>35.698036</geo:lat> 

<dc:subject 

xmlns:dc="dc">2</dc:subject> 

<cputime>9</cputime> 

</item> 

</channel> 

</rss> 

2,3 -Base.jpg, P1_MAXHEIGHT_END.jpg 
Base.jpg  is a jpeg image representing the calculation space before the tsunami 
arrival. It is an image with the number of horizontal pixels equal to the number of 
horizontal calculation cells and the vertical pixels as the number of vertical cells. In 
general the bathymetry and topography are shown. 
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P1_MAXHEIGHT_END.jpg represents the maximum height at the end of the 
calculation and represents the basis for the locations and sea level measurements 
that are overlaid in the analysis window. The size is the same as base.jpg. 
 
4- outres1.gif 
This is a gif animation showing the evolution of the tsunami wave. It is optional. 
 
5. Timeline data 
These are very important data because represent the result of the calculation vs 
time at each calculation point. Two types of files are possible: netcdf and geotiff. 
The first one are much quicker to be loaded while the second one allow to have 
snapshot at the various times that can be used in a GIS environment; the loading 
time is longer and for very long calculations is not a very convenient method. 
 
5a. Netcdf files 
NetCDF (network Common Data Form) is a set of interfaces for array-oriented 
data access and a freely-distributed collection of data access libraries for C, 
Fortran, C++, Java, and other languages. The netCDF libraries support a 
machine-independent format for representing scientific data. Together, the 
interfaces, libraries, and format support the creation, access, and sharing of 
scientific data (http://www.unidata.ucar.edu/ ). 
 
In the TAT environment every variable (bathymetry data, height or velocity data) 
has its own NETCDF file which contains all the values of the calculation space at 
each time step. The following variables are used: 
 
LON  for longitude 
LAT  for latitude 
TIME for the elapsed time 
 
The dependent variables may be 
HA for the height (m) 
U for the horizontal velocity (m/s) 
V for the vertical velocity (m/s) 
 
The result of the command for one sample file for height  
 
ncdump -h netcdf_h.nc 

 
is the following 
  

http://www.unidata.ucar.edu/


 

 44 

 
netcdf  netcdf_h { 

dimensions: 

        LON = 720 ; 

        LAT = 622 ; 

        TIME = UNLIMITED ; // (213 currently) 

variables: 

        double LON(LON) ; 

                LON:units = "degrees_east" ; 

                LON:point_spacing = "even" ; 

        double LAT(LAT) ; 

                LAT:units = "degrees_north" ; 

                LAT:point_spacing = "even" ; 

        double TIME(TIME) ; 

                TIME:units = "seconds" ; 

        float HA(TIME, LAT, LON) ; 

                HA:units = "m" ; 

 

// global attributes: 

                :hystory = "SWAN 1.0 - JRC Ispra European Commission" ; 

} 

 
 
5b. geoTiff files 

GeoTIFF is a public domain metadata standard which allows georeferencing 
information to be embedded within a TIFF file. The potential additional information 
includes map projection, coordinate systems, ellipsoids, datums, and everything else 
necessary to establish the exact spatial reference for the file. The GeoTIFF format is 
fully compliant with TIFF 6.0, so software incapable of reading and interpreting the 
specialized metadata will still be able to open a GeoTIFF format file. 

Several libraries are available to read or write geoTiff files, such as gdal libraries. An 
overview is present at http://trac.osgeo.org/geotiff/  . 

The TAT implementation relies on a series of geoTIFF files, one for each time. 
Therefore if geoTIFF format is specified there will be n files for any of the n data point 
and the system will open and read all the n files to create the timeline plots. In order to 
know which files are used we use a listfiles.txt file, an ASCII space separated file which 
contain the list of the files assigned to the right time in seconds. 

This is the initial part of a listfiles.txt file: 

*time             HA          U           V 

*list of files for current case ./listfiles.txt 

0.000000 TIF_H_00000000.tif TIF_U_00000000.tif TIF_V_00000000.tif  

123.250000 TIF_H_00000123.tif TIF_U_00000123.tif TIF_V_00000123.tif  

246.500000 TIF_H_00000246.tif TIF_U_00000246.tif TIF_V_00000246.tif  

369.750000 TIF_H_00000369.tif TIF_U_00000369.tif TIF_V_00000369.tif  

493.000000 TIF_H_00000493.tif TIF_U_00000493.tif TIF_V_00000493.tif  

616.250000 TIF_H_00000616.tif TIF_U_00000616.tif TIF_V_00000616.tif  

739.500000 TIF_H_00000739.tif TIF_U_00000739.tif TIF_V_00000739.tif  

862.750000 TIF_H_00000862.tif TIF_U_00000862.tif TIF_V_00000862.tif 

… 

http://trac.osgeo.org/geotiff/
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The first line identifies the time and the quantities (HA for height, U and V for 
velocities), the second line is a comment and then the other lines report the time in first 
column and the names of the geoTif files that will be found in the directory where the 
listfiles.txt is present. 

6. Bathymetry.tif 

This is a geoTIFF file representing the bathymetry data used for the calculation 

7. WPFiles.tar or WTFiles.tar 
These are compressed files containing one file per each location and containing 
the time trend for that particular location. It is a way to reduce the loading time of 
the quantities.  
 
The content of each file inside these compressed file, named with the name of the 
location, is something like 
 
* Location: Abe lat=33.787910 - lon=134.637207 
14280.000000,0.064485,0.064485 
14400.000000,0.044906,0.064485 
14520.000000,0.044906,0.064485 
14640.000000,0.044906,0.064485 
14760.000000,0.045670,0.064485 
14880.000000,0.044906,0.064485 
15000.000000,0.044906,0.064485 
15120.000000,0.044906,0.064485  
 

Showing the time in seconds and the height. The values starts when the location is 
reached by the wave. 


